
@babackova

PŘÍPRAVA KE ZKOUŠCE DA-100
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@babackova

• Jsem pražák žijící v Brně 

• Pracuji jako M365 konzultant pro společnost Konica Minolta

• Jsem jedním ze zakladatelů spolku iLikeSharePoint CZ  (Czech SPUG)

• Jsem občasným mentorem Power BI projektů pro CzechITas

• Zajímám se o vesmír, digitální fotografii a Japonsko

Jana Babáčková

Najdete me na socialnich sitich:

Twiter: https://twitter.com/babackova

LinkedIn: https://www.linkedin.com/in/janababackova

Facebook: https://www.facebook.com/Molik
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@babackova

DA-100, co to je a proč ji chceme zkusit

1. Příprava dat, práce s daty

2. Vizualizace

3. Optimalizace

4. Power BI v online světě

5. Modelování dat & DAX

6. Analytické funkce

Co nás dnes čeká

3 Options

A wonderful serenity

A wonderful serenity

Legenda
Téma najdete v archívu WUG přednášek

Odkaz na více informací

Článek, Learn portál kapitola nebo YouTube video
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@babackova

DA-100
ANALYZING DATA WITH MICROSOFT POWER BI

Kódové označení je DA-100 a zkouška je tu s námi od dubna 2020, aktuálně už asi ve 

čtvrté edici s poslední aktualizací ze září 2021. 

Exam questions: ~60 per one exam, 133 total

Passing score: 700/1000

Price: may vary from 160 USD to 250 USD based on region

Time: 90 min

Language: English

Pokud zkousku zvladnete, dostanete do par hodin vritualni odznacek, ktery se ted 

nove prestehoval z webu Acclaim na Credly.com. 

Jen pro uplonost dodavam, ze 70-778 je pryc, vyprsela v lednu 2021, 70-779 je take 

pryc, MCSA:  pro BI Reporting uz take nemuzete ziskat, jedine co ted mame je role-

based DA-100. 

Pokud se vam uceni zalibi a chteli byste pokracovat, pak hodne vzdalene pribuzne ve 

stejne kategorii jsou byt DP-100 Azure Data Scientist Associate kde je to machine 

learning nebo PL-200, Power Platform Functional Consultant Associate, kde se 

dotknete take Dataverse, Power Apps, Power Automate, a chatbotu, ale je to uz mimo 
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nase Power BI, to bez pochyby. Jen patri pod stejnou “Data & AI” competenci.  

https://docs.microsoft.com/en-us/learn/certifications/power-platform-functional-

consultant-associate/

https://partner.microsoft.com/en-us/membership/competencies#tab-content-3

4



Co nám 
pomůže s 
přípravou

1 2

Referencni kniha je od vydavatelství Microsoft Press, napsal ji Daniil Maslyuk, má 288 

stránek, je anglicky a stojí přibližně 1000 korun českých. Co Vám může pomoci je také 

„The definitive guide to DAX“, kniha kteoru napsal Marco Russo nebo DAX reference 

guide z webu https://docs.microsoft.com/en-us/dax/dax-function-reference 

Videí je moc. Oficiální videa d firmy Microsoft můžete najít na Microsoft Learn portále, 

Jsou organizovaná do celků nazvaných „Learning paths“ vždy k nějaké roli nebo podle 

souvislostí a najdete tady přes 19 hodin obsahu. Neoficiální, ale taky dobré přípravné 

video plné referencí, které má ale jen dvě hodiny připravil jistý belgičan, v angličtine a 

můžete ho najít na YouTube, link najdete v prezentaci v poznámkách. V celé mojí 

prezentaci najdete hned tři obrázky z jeho referenčního videa, protože jsou velmi

názorné. https://www.youtube.com/watch?v=Tfk3ae0qz3A

https://docs.microsoft.com/en-us/learn/paths/data-analytics-microsoft/

https://docs.microsoft.com/en-us/learn/paths/prepare-data-power-bi/

https://docs.microsoft.com/en-us/learn/paths/model-power-bi/

https://docs.microsoft.com/en-us/learn/paths/visualize-data-power-bi/

https://docs.microsoft.com/en-us/learn/paths/perform-analytics-power-bi/

https://docs.microsoft.com/en-us/learn/paths/manage-workspaces-datasets-power-

bi/
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Proč chtít DA-100?

Top 10 Highest 

Paying Microsoft 

Certifications 2021

1. AZ-104 (Azure)

2. AZ-900 (Azure)

3. DA-100 <-

… (all the rest Azure)

Nejen, že je jediná ve svém oboru, pro Power BI zatím nic jiného nemáme, ale je nová, 

žádaná, praktická a je to dobrý přehled toho, co Power BI nabízí a umí nebo naopak 

kde jsou jeho limity. Pro každého datového analytika, designéra reportů nebo 

začátečníka je to dobrý start. 
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Co Vám nenabídnu a proč

Před zkouškou samotnou Vám doporučuji projít několik vzorových otázek volně 

dostupných z Internetu. Vždy ale přemýšlejte nad odpovědí – nemusí být správná. 

Klikejte, zkoušejte a nebo se poraďte s někým dalším. Neexistuje žádný web, který by 

měl 100% otázek z testu a správných, ani za peníze. 

https://www.itexams.com

https://www.examtopics.com
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Typy otázek

1. Dlouhé „Case Studies“

2. Krátké s možnostmi „a b c d e f“

3. Krátké s možností výběru (drop down)

4. Sety tří otázek typu „ano / ne“ bez možnosti návratu

5. Otázky s obrázkem k analýze

6. „Drag & drop” otázky, kde záleží na odpovědi i pořadí kroků
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@babackova@babackova

1 / PŘÍPRAVA A PRÁCE S DATY
5
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1. Vybrat, nastavit a použít správný datový zdroj

2. Správně identifikovat, změnit a nastavit datový typ sloupce, přejmenovat sloupce

3. Identifikovat a nahradit prázdné pole, určit unikátní pole, najít duplicity

4. Identifikovat a nastavit správný typ vazby a směr

5. Víte co je „storage mode“ a jak se s ním pracuje

6. Pracovat s transformovanými daty

7. Uložit nebo publikovat svoji práci 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

…včetně změny nastavení již existujícího a to zejména pro excel soubor, csv, 

SharePoint list i knihovnu, OneDrive, JSON a nebo SQL a včetně načítání parametrů

https://docs.microsoft.com/en-us/learn/modules/get-data
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@babackova

1. Vybrat, nastavit a použít správný datový zdroj

2. Správně identifikovat, změnit a nastavit datový typ sloupce, přejmenovat sloupce

3. Identifikovat a nahradit prázdné pole, určit unikátní pole, najít duplicity

4. Identifikovat a nastavit správný typ vazby a směr

5. Víte co je „storage mode“ a jak se s ním pracuje

6. Pracovat s transformovanými daty

7. Uložit nebo publikovat svoji práci 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… včetně funkce „use first row as a headers“

https://docs.microsoft.com/en-us/learn/paths/prepare-data-power-bi
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1. Vybrat, nastavit a použít správný datový zdroj

2. Správně identifikovat, změnit a nastavit datový typ sloupce, přejmenovat sloupce

3. Identifikovat a nahradit prázdné pole, určit unikátní pole, najít duplicity

4. Identifikovat a nastavit správný typ vazby a směr

5. Víte co je „storage mode“ a jak se s ním pracuje

6. Pracovat s transformovanými daty

7. Uložit nebo publikovat svoji práci 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… viz obrázek na následujícím snímku, který v sobě urkývá odpověď na spousty 

otázek

https://docs.microsoft.com/en-us/learn/modules/clean-data-power-bi
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Column quality, profile &
distribution
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1. Vybrat, nastavit a použít správný datový zdroj

2. Správně identifikovat, změnit a nastavit datový typ sloupce, přejmenovat sloupce

3. Identifikovat a nahradit prázdné pole, určit unikátní pole, najít duplicity

4. Identifikovat a nastavit správný typ vazby a směr

5. Víte co je „storage mode“ a jak se s ním pracuje

6. Pracovat s transformovanými daty

7. Uložit nebo publikovat svoji práci 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… viz obrázek na následujícím snímku

https://docs.microsoft.com/en-us/learn/modules/model-data-power-bi
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Relations, filtering

• Relationships 1:1, 1:*, *:1, *:*

• Filtering depends on relationships

• Cross filter direction: Single, Both

• Relationships active / inactive

• Inactive relationships won’t filter unless 

you use DAX function CROSSFILTER

Inactive relationships won’t filter unless you use DAX function CROSSFILTER
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1. Vybrat, nastavit a použít správný datový zdroj

2. Správně identifikovat, změnit a nastavit datový typ sloupce, přejmenovat sloupce

3. Identifikovat a nahradit prázdné pole, určit unikátní pole, najít duplicity

4. Identifikovat a nastavit správný typ vazby a směr

5. Víte co je „storage mode“ a jak se s ním pracuje

6. Pracovat s transformovanými daty

7. Uložit nebo publikovat svoji práci 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… viz obrázek na následujícím snímku

https://docs.microsoft.com/en-us/learn/paths/prepare-data-power-bi
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Storage mode

• Import

As you create a visualization, PBI uses the 

imported data, refreshing the data will 

re-import entire dataset again

• DirectQuery

As you create visualization, PBI queries 

the data source, data are always up-to-

date, not all data sources compatible

• Dual

1 GB limit for dataset stored in PBI service

Can be refreshed up to 8x per day, up to 48x per day using premium
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1. Vybrat, nastavit a použít správný datový zdroj

2. Správně identifikovat, změnit a nastavit datový typ sloupce, přejmenovat sloupce

3. Identifikovat a nahradit prázdné pole, určit unikátní pole, najít duplicity

4. Identifikovat a nastavit správný typ vazby a směr

5. Víte co je „storage mode“ a jak se s ním pracuje

6. Pracovat s transformovanými daty

7. Uložit nebo publikovat svoji práci 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… i pro to mám velmi názorný obrázek

https://docs.microsoft.com/en-us/learn/modules/clean-data-power-bi
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Data transformation

1. TRANSPOSE

Move columns to rows

2. PIVOT COLUMN

Change rows into columns

3. UNPIVOT COLUMNS

Changes columns into rows, creates 

two header names Attributes & Values

1

2

3

Nezapmínejte prosím na to, že funkce UNPIVOT vám sama o sobě vyrobí dva sloupce 

s názvem Attributes & Values. 
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1. Vybrat, nastavit a použít správný datový zdroj

2. Správně identifikovat, změnit a nastavit datový typ sloupce, přejmenovat sloupce

3. Identifikovat a nahradit prázdné pole, určit unikátní pole, najít duplicity

4. Identifikovat a nastavit správný typ vazby a směr

5. Víte co je „storage mode“ a jak se s ním pracuje

6. Pracovat s transformovanými daty

7. Uložit nebo publikovat svoji práci 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/learn/modules/publish-share-power-bi
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2 / VIZUALIZACE
15
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1. Identifikovat, přidat a nastavit správný typ vizualizace k vybranému vzorku dat

2. Přidat a použít vizualizaci ze „store“ nebo ze souboru

3. Třídit a filtrovat data ve vizualizacích, exportovat data z vizualizací

4. Použít, nastavit a synchronizovat posuvníky mezi stránkami reportu

5. Nastavit a použít podmíněné formátování

6. Přidat a nastavit skupiny, “tooltips” a komentáře 

7. Pracovat s navigací, tlačítky a záložkami 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-types-for-

reports-and-q-and-a

https://docs.microsoft.com/en-us/power-bi/visuals/service-getting-started-with-

color-formatting-and-axis-properties

22



@babackova

1. Identifikovat, přidat a nastavit správný typ vizualizace k vybranému vzorku dat

2. Přidat a použít vizualizaci ze „store“ nebo ze souboru

3. Třídit a filtrovat data ve vizualizacích, exportovat data z vizualizací

4. Použít, nastavit a synchronizovat posuvníky mezi stránkami reportu

5. Nastavit a použít podmíněné formátování

6. Přidat a nastavit skupiny, “tooltips” a komentáře 

7. Pracovat s navigací, tlačítky a záložkami 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-bi/developer/visuals/import-visual
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1. Identifikovat, přidat a nastavit správný typ vizualizace k vybranému vzorku dat

2. Přidat a použít vizualizaci ze „store“ nebo ze souboru

3. Třídit a filtrovat data ve vizualizacích, exportovat data z vizualizací

4. Použít, nastavit a synchronizovat posuvníky mezi stránkami reportu

5. Nastavit a použít podmíněné formátování

6. Přidat a nastavit skupiny, “tooltips” a komentáře 

7. Pracovat s navigací, tlačítky a záložkami 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://okviz.com/blog/design-guide-for-power-bi-slicers-and-filters/
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1. Identifikovat, přidat a nastavit správný typ vizualizace k vybranému vzorku dat

2. Přidat a použít vizualizaci ze „store“ nebo ze souboru

3. Třídit a filtrovat data ve vizualizacích, exportovat data z vizualizací

4. Použít, nastavit a synchronizovat posuvníky mezi stránkami reportu

5. Nastavit a použít podmíněné formátování

6. Přidat a nastavit skupiny, “tooltips” a komentáře 

7. Pracovat s navigací, tlačítky a záložkami 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… plus drobné připomenutí na následujícím snímku

https://docs.microsoft.com/en-us/power-bi/developer/visuals/enable-sync-slicers
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Slicers Sync

• View > Sync Slicers

• Slicers can be organized into Groups
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@babackova

1. Identifikovat, přidat a nastavit správný typ vizualizace k vybranému vzorku dat

2. Přidat a použít vizualizaci ze „store“ nebo ze souboru

3. Třídit a filtrovat data ve vizualizacích, exportovat data z vizualizací

4. Použít, nastavit a synchronizovat posuvníky mezi stránkami reportu

5. Nastavit a použít podmíněné formátování

6. Přidat a nastavit skupiny, “tooltips” a komentáře 

7. Pracovat s navigací, “tabs”, tlačítky a záložkami 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-bi/create-reports/desktop-conditional-

table-formatting
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@babackova

1. Identifikovat, přidat a nastavit správný typ vizualizace k vybranému vzorku dat

2. Přidat a použít vizualizaci ze „store“ nebo ze souboru

3. Třídit a filtrovat data ve vizualizacích, exportovat data z vizualizací

4. Použít, nastavit a synchronizovat posuvníky mezi stránkami reportu

5. Nastavit a použít podmíněné formátování

6. Přidat a nastavit skupiny, “tooltips” a komentáře 

7. Pracovat s navigací, tlačítky a záložkami 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/learn/modules/perform-analytics-power-bi/4-

group-data

https://docs.microsoft.com/en-us/power-bi/create-reports/desktop-tooltips
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1. Identifikovat, přidat a nastavit správný typ vizualizace k vybranému vzorku dat

2. Přidat a použít vizualizaci ze „store“ nebo ze souboru

3. Třídit a filtrovat data ve vizualizacích, exportovat data z vizualizací

4. Použít, nastavit a synchronizovat posuvníky mezi stránkami reportu

5. Nastavit a použít podmíněné formátování

6. Přidat a nastavit skupiny, “tooltips”a komentáře 

7. Pracovat s navigací, tlačítky a záložkami 

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-bi/create-reports/desktop-buttons

https://docs.microsoft.com/en-us/power-bi/create-reports/desktop-bookmarks
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Buttons, navigation

• Use bookmarks like a “snapshots” or 

“reset” when multiple filters applied

• You can build an entire navigation 

experience with the button 

Action type Page navigation

• Tabs order is crucial for mobile app , find 

ribbon menu View > Selection pane > 

Tab order  section

Nezapmente, ze zalozky v report dole, jsou pages v cloudu, zobrazene po leve strane

(ale jde to prepnout)

Na poradi zalozek zalezi pro mobilni aplikaci
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Bonus: Paginated reports

• Created in Report Builder

• Requires PRO license to share on cloud

• Better handle parameters

• Supports Deployment Pipelines

Strankovane sestavy

https://docs.microsoft.com/cs-cz/power-bi/paginated-reports/paginated-reports-

report-builder-power-bi
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3 / OPTIMALIZACE
25
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@babackova

1. Odstranit duplicitní nebo nepotřebné sloupce

2. Identifikovat, nastavit a změnit nevhodné datové typy, rozdělit datum a čas

3. Optimalizovat datový model, použít nástroj „Performance Analyzer“ 

4. Se umíte správně rozhodnout kdy použít „custom columns“, „custom tables“ a „meaures“ 

5. Umíte vypnout „Power Query on load“ a umíte pracovat s „Direct query“

6. Umíte vypnout automatické škálování data a času

7. Umíte pracovat s „CROSSFILTER“ funkcí

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… odstranit nebo schovat

https://docs.microsoft.com/en-us/power-bi/guidance/import-modeling-data-

reduction#remove-unnecessary-columns
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1. Odstranit duplicitní nebo nepotřebné sloupce

2. Identifikovat, nastavit a změnit nevhodné datové typy, rozdělit datum a čas

3. Optimalizovat datový model, použít nástroj „Performance Analyzer“ 

4. Se umíte správně rozhodnout kdy použít „custom columns“, „custom tables“ a „meaures“ 

5. Umíte vypnout „Power Query on load“ a umíte pracovat s „Direct query“

6. Umíte vypnout automatické škálování data a času

7. Umíte pracovat s „CROSSFILTER“ funkcí

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/learn/modules/clean-data-power-bi/

https://www.exceljetconsult.com.ng/home/blog/power-query-split-date-and-time-

into-separate-columns/
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1. Odstranit duplicitní nebo nepotřebné sloupce

2. Identifikovat, nastavit a změnit nevhodné datové typy, rozdělit datum a čas

3. Optimalizovat datový model, použít nástroj „Performance Analyzer“ 

4. Se umíte správně rozhodnout kdy použít „custom columns“, „custom tables“ a „meaures“ 

5. Umíte vypnout „Power Query on load“ a umíte pracovat s „Direct query“

6. Umíte vypnout automatické škálování data a času

7. Umíte pracovat s „CROSSFILTER“ funkcí

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-bi/create-reports/desktop-performance-

analyzer

https://www.elegantbi.com/post/top10bestpractices
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1. Odstranit duplicitní nebo nepotřebné sloupce

2. Identifikovat, nastavit a změnit nevhodné datové typy, rozdělit datum a čas

3. Optimalizovat datový model, použít nástroj „Performance Analyzer“ 

4. Se umíte správně rozhodnout kdy použít „custom columns“, „custom tables“ a „meaures“ 

5. Umíte vypnout „Power Query on load“ a umíte pracovat s „Direct query“

6. Umíte vypnout automatické škálování data a času

7. Umíte pracovat s „CROSSFILTER“ funkcí

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://www.sqlbi.com/articles/comparing-dax-calculated-columns-with-power-

query-computed-columns/
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1. Odstranit duplicitní nebo nepotřebné sloupce

2. Identifikovat, nastavit a změnit nevhodné datové typy, rozdělit datum a čas

3. Optimalizovat datový model, použít nástroj „Performance Analyzer“ 

4. Se umíte správně rozhodnout kdy použít „custom columns“, „custom tables“ a „meaures“ 

5. Umíte vypnout „Power Query on load“ a umíte pracovat s „Direct query“

6. Umíte vypnout automatické škálování data a času

7. Umíte pracovat s „CROSSFILTER“ funkcí

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… vcetne poznámek na následujícím snímku

https://docs.microsoft.com/en-us/power-bi/guidance/import-modeling-data-

reduction#disable-power-query-query-load
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Power Query load tricks

• Options > Global > Data Load

(Type detection, Time intelligence)

• Options > Current file > Data Load

(Auto Date/Time, Relationships, Q&A)

• Options > Current file > Query reduction

(Filters, Slicers, number of queries)

Nekteri jeste porad muzou videt tento dialog pro starsi verze Power Bi desktop, tam 

je sice voleb trosku min, ale jsou jasne popsane…

38



@babackova

1. Odstranit duplicitní nebo nepotřebné sloupce

2. Identifikovat, nastavit a změnit nevhodné datové typy, rozdělit datum a čas

3. Optimalizovat datový model, použít nástroj „Performance Analyzer“ 

4. Se umíte správně rozhodnout kdy použít „custom columns“, „custom tables“ a „meaures“ 

5. Umíte vypnout „Power Query on load“ a umíte pracovat s „Direct query“

6. Umíte vypnout automatické škálování data a času

7. Umíte pracovat s „CROSSFILTER“ funkcí

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… což jsme probrali v předchozím snímku

https://docs.microsoft.com/en-us/power-bi/guidance/import-modeling-data-

reduction#disable-auto-datetime
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1. Odstranit duplicitní nebo nepotřebné sloupce

2. Identifikovat, nastavit a změnit nevhodné datové typy, rozdělit datum a čas

3. Optimalizovat datový model, použít nástroj „Performance Analyzer“ 

4. Se umíte správně rozhodnout kdy použít „custom columns“, „custom tables“ a „meaures“ 

5. Umíte vypnout „Power Query on load“ a umíte pracovat s „Direct query“

6. Umíte vypnout automatické škálování data a času

7. Umíte pracovat s „CROSSFILTER“ funkcí

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://radacad.com/dax-crossfilter-function-in-power-bi-write-the-formula-both-

directional-but-keep-the-relationship-single-directional
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4 / POWER BI ONLINE
35
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1. Založit a spravovat „dashboards“ včetně témat, mobilního zobrazení a živého propojení

2. Založit a spravovat „workspaces“ včetně nastavování rolí a práv, založit a spravovat „apps“

3. Nastavit správný „data refresh“ a „schedule refresh“

4. Identifikovat závislosti, umíte založit „dataflow“

5. Pracovat s velkými datasety, importovanými datasety, certifikovanými datasety

6. Nastavit a spravovat RLS, pracovat s klasifikací dat a „sensitive labels“

7. Umíte založit a nastavit „alerts“ a „subscriptions“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… včetně podrobností na následujícím snímku

https://docs.microsoft.com/en-us/learn/modules/create-dashboards-power-bi/

https://docs.microsoft.com/en-us/power-bi/create-reports/desktop-create-phone-

report
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Dashboards

• Pin a visualization to Dashboard

• Create Dashboard

• Change Dashboard theme

• Create mobile layout

• Open a Lineage view

• Open usage metrics

• Share with others

• Leave a comment

• Subscribe for changes

(alert vs. subscription)
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1. Založit a spravovat „dashboards“ včetně témat, mobilního zobrazení a živého propojení

2. Založit a spravovat „workspaces“ včetně nastavování rolí a práv, založit a spravovat „apps“

3. Nastavit správný „data refresh“ a „schedule refresh“

4. Identifikovat závislosti, umíte založit „dataflow“

5. Pracovat s velkými datasety, importovanými datasety, certifikovanými datasety

6. Nastavit a spravovat RLS, pracovat s klasifikací dat a „sensitive labels“

7. Umíte založit a nastavit „alerts“ a „subscriptions“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… včetně podrobností na následujícím snímku

https://docs.microsoft.com/en-us/learn/modules/create-manage-workspaces-power-

bi/

44



@babackova

Workspaces

• Create workspace

• Check the Lineage view

• Create app (PRO)

• Workspace roles (PRO)  ->

• License mode 

(Pro, per user, per capacity, embed)

Jestli bude workspace pouzivat OneDrive se vybira pri jeho zalozeni, stejne jako

moznost nechat contributors aktualizovat appku vyrobenou z toho konkretniho

zakladaneho pracovniho prostoru. 
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1. Založit a spravovat „dashboards“ včetně témat, mobilního zobrazení a živého propojení

2. Založit a spravovat „workspaces“ včetně nastavování rolí a práv, založit a spravovat „apps“

3. Nastavit správný „data refresh“ a „schedule refresh“

4. Identifikovat závislosti, umíte založit „dataflow“

5. Pracovat s velkými datasety, importovanými datasety, certifikovanými datasety

6. Nastavit a spravovat RLS, pracovat s klasifikací dat a „sensitive labels“

7. Umíte založit a nastavit „alerts“ a „subscriptions“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

If you are using the On-premises data gateway to refresh data, you do not need to 

supply credentials, as they are defined for the data source by the gateway 

administrator.

If you are using the personal gateway to refresh data, you must supply the credentials 

to connect to the back-end data source. If you connected to an app from an online 

service, the credentials you entered to connect are carried over for scheduled refresh.

The Scheduled refresh section is where you define the frequency and time slots to 

refresh the dataset. Some data sources do not require a gateway to be configurable 

for refresh; other data sources require a gateway.

https://docs.microsoft.com/en-us/power-bi/connect-data/refresh-scheduled-refresh

46



@babackova

1. Založit a spravovat „dashboards“ včetně témat, mobilního zobrazení a živého propojení

2. Založit a spravovat „workspaces“ včetně nastavování rolí a práv, založit a spravovat „apps“

3. Nastavit správný „data refresh“ a „schedule refresh“

4. Identifikovat závislosti, umíte založit „dataflow“

5. Pracovat s velkými datasety, importovanými datasety, certifikovanými datasety

6. Nastavit a spravovat RLS, pracovat s klasifikací dat a „sensitive labels“

7. Umíte založit a nastavit „alerts“ a „subscriptions“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-bi/transform-model/dataflows/dataflows-

introduction-self-service
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1. Založit a spravovat „dashboards“ včetně témat, mobilního zobrazení a živého propojení

2. Založit a spravovat „workspaces“ včetně nastavování rolí a práv, založit a spravovat „apps“

3. Nastavit správný „data refresh“ a „schedule refresh“

4. Identifikovat závislosti, umíte založit „dataflow“

5. Pracovat s velkými datasety, importovanými datasety, certifikovanými datasety

6. Nastavit a spravovat RLS, pracovat s klasifikací dat a „sensitive labels“

7. Umíte založit a nastavit „alerts“ a „subscriptions“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

Certified indicates that content has been reviewed by some authorized person and 

meets organization standards

By a promotion, content owner offers others easier retrieval

https://docs.microsoft.com/en-us/power-bi/admin/service-premium-large-models

… vice viz následující snímek
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Large Datasets storage format

• PRO feature

• Dataset Settings > Premium

Dataset Settings> Large dataset storage format

• Datasets larger than 10 GB

• Downloading .pbix file may fail

• Maximum capacity depends on SKU

• Set-PowerBIDataset -Id <Dataset ID> -TargetStorageMode PremiumFiles

(Get-PowerBIDataset -Scope Organization -Id <Dataset ID> -Include actualStorage).ActualStorage

Pro datasety nad 10 GB

https://docs.microsoft.com/en-us/power-bi/admin/service-premium-large-models
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1. Založit a spravovat „dashboards“ včetně témat, mobilního zobrazení a živého propojení

2. Založit a spravovat „workspaces“ včetně nastavování rolí a práv, založit a spravovat „apps“

3. Nastavit správný „data refresh“ a „schedule refresh“

4. Identifikovat závislosti, umíte založit „dataflow“

5. Pracovat s velkými datasety, importovanými datasety, certifikovanými datasety

6. Nastavit a spravovat RLS, pracovat s klasifikací dat a „sensitive labels“

7. Umíte založit a nastavit „alerts“ a „subscriptions“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… s více podrobnostmi na následujícím snímku

https://docs.microsoft.com/en-us/power-bi/report-server/row-level-security-report-

server

https://docs.microsoft.com/en-us/power-bi/admin/service-security-apply-data-

sensitivity-labels
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RLS, Security labels

• Role Level Security  (filter data)  ->

(Desktop app > Modeling > Manage roles

Desktop app > Modeling > View as)

• Sensitivity Labels  (encrypt data) 

(M365 compliance > Information Protection > enable

M365 compliance > Data Classification

PBI Cloud > workspace > Sensitivity column

PBI Desktop > Sensitivity in Home Ribbon)

Pro RLS plati, ze nejdrive musite mit zalozene role a to nejdrive z Desktop aplikace. I 

kdyz uz nejake mate v cloudu, potrebujete je zalozit znovu pres desktop aplikaci a 

publikovat do cloudu. Role jdou nastavit I pres DAX. RLS pouziva single – directional 

filter by default, ale to muzete manualne zmenit. 

Sensitivity labels jsou trosku komplexnejsi vec. Musi byt nejdrive povolene pro tenant, 

pak zalozene jedna po druhe a pres policy distribuovane na vybrany okruh obsahu –

emaily, dokumenty a nebo power bi. A publikovani policy muze trvat az 24 hodin. 

Sensitivity labels se dedi a nedaji se pouzit pro paginated reports. 

Sensitivity labels for containers aren't supported with Office 365 Content Delivery 

Networks (CDNs).

https://docs.microsoft.com/en-us/microsoft-365/compliance/sensitivity-

labels?view=o365-worldwide
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1. Založit a spravovat „dashboards“ včetně témat, mobilního zobrazení a živého propojení

2. Založit a spravovat „workspaces“ včetně nastavování rolí a práv, založit a spravovat „apps“

3. Nastavit správný „data refresh“ a „schedule refresh“

4. Identifikovat závislosti, umíte založit „dataflow“

5. Pracovat s velkými datasety, importovanými datasety, certifikovanými datasety

6. Nastavit a spravovat RLS, pracovat s klasifikací dat a „sensitive labels“

7. Umíte založit a nastavit „alerts“ a „subscriptions“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-bi/create-reports/service-set-data-alerts

https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-report-

subscribe
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Bonus: Tools

• Power BI Admin

(workload metrics)

• Power BI Premium Capacity Metric  (PRO)  ->

(workload, datasets, workspaces, system)

• Azure Speed Test

(ethernet connectivity)

• Power BI Performance Analyzer

(visuals and their queries monitoring)
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5 / MODELOVÁNÍ DAT & DAX
55

54



@babackova

1. Vytvořit a spravovat novou tabulku a definovat její vazby

2. Identifikovat případy, kdy jsou vhodné vazby 1:1, 1:many, many:1, many to many 

3. Definovat a použít „measures“, „custom columns“ a vytvářet sloupce s hierarchií

4. Identifikovat a použít správně „CROSSFILTER“ nebo „bi-directional“ filtering

5. Identifikovat a použít základní DAX výrazy, Power Query nebo M

6. Pracovat s „Power Query“ editorem a „Advanced editorem“

7. Pracovat s aktivními vazbami a modelem typu „hvězda“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-tables

https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-relationships-

understand
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1. Vytvořit a spravovat novou tabulku a definovat její vazby

2. Identifikovat případy, kdy jsou vhodné vazby 1:1, 1:many, many:1, many to many 

3. Definovat a použít „measures“, „custom columns“ a vytvářet sloupce s hierarchií

4. Identifikovat a použít správně „CROSSFILTER“ nebo „bi-directional“ filtering

5. Identifikovat a použít základní DAX výrazy, Power Query nebo M

6. Pracovat s „Power Query“ editorem a „Advanced editorem“

7. Pracovat s aktivními vazbami a modelem typu „hvězda“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-bi/guidance/relationships-many-to-many
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1. Vytvořit a spravovat novou tabulku a definovat její vazby

2. Identifikovat případy, kdy jsou vhodné vazby 1:1, 1:many, many:1, many to many 

3. Definovat a použít „measures“, „custom columns“ a vytvářet sloupce s hierarchií

4. Identifikovat a použít správně „CROSSFILTER“ nebo „bi-directional“ filtering

5. Identifikovat a použít základní DAX výrazy, Power Query nebo M

6. Pracovat s „Power Query“ editorem a „Advanced editorem“

7. Pracovat s aktivními vazbami a modelem typu „hvězda“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-quick-

measures

https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-tutorial-

create-calculated-columns

https://spreadsheeto.com/power-bi-hierarchy/

https://businessintelligist.com/2017/08/21/power-bi-tutorial-flatten-parent-child-

hierarchy/
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1. Vytvořit a spravovat novou tabulku a definovat její vazby

2. Identifikovat případy, kdy jsou vhodné vazby 1:1, 1:many, many:1, many to many 

3. Definovat a použít „measures“, „custom columns“ a vytvářet sloupce s hierarchií

4. Identifikovat a použít správně „CROSSFILTER“ nebo „bi-directional“ filtering

5. Identifikovat a použít základní DAX výrazy, Power Query nebo M

6. Pracovat s „Power Query“ editorem a „Advanced editorem“

7. Pracovat s aktivními vazbami a modelem typu „hvězda“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-bidirectional-

filtering
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1. Vytvořit a spravovat novou tabulku a definovat její vazby

2. Identifikovat případy, kdy jsou vhodné vazby 1:1, 1:many, many:1, many to many 

3. Definovat a použít „measures“, „custom columns“ a vytvářet sloupce s hierarchií

4. Identifikovat a použít správně „CROSSFILTER“ nebo „bi-directional“ filtering

5. Identifikovat a použít základní DAX výrazy, Power Query nebo M

6. Pracovat s „Power Query“ editorem a „Advanced editorem“

7. Pracovat s aktivními vazbami a modelem typu „hvězda“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… s více podrobnostmi na dalším snímku

https://download.microsoft.com/download/0/F/B/0FBFAA46-2BFD-478F-8E56-

7BF3C672DF9D/QuickStart - Learn DAX Basics in 30 Minutes.pdf

https://radacad.com/book-overview-the-definitive-guide-to-power-query-in-power-

bi-and-excel

https://docs.microsoft.com/en-us/powerquery-m/quick-tour-of-the-power-query-m-

formula-language
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Functions, statements

Source: https://www.youtube.com/watch?v=Tfk3ae0qz3A

https://www.youtube.com/watch?v=Tfk3ae0qz3A
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1. Vytvořit a spravovat novou tabulku a definovat její vazby

2. Identifikovat případy, kdy jsou vhodné vazby 1:1, 1:many, many:1, many to many 

3. Definovat a použít „measures“, „custom columns“ a vytvářet sloupce s hierarchií

4. Identifikovat a použít správně „CROSSFILTER“ nebo „bi-directional“ filtering

5. Identifikovat a použít základní DAX výrazy, Power Query nebo M

6. Pracovat s „Power Query“ editorem a „Advanced editorem“

7. Pracovat s aktivními vazbami a modelem typu „hvězda“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://docs.microsoft.com/en-us/power-query/power-query-ui

https://blog.enterprisedna.co/best-practice-tips-for-using-the-advanced-editor-in-

power-bi/
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1. Vytvořit a spravovat novou tabulku a definovat její vazby

2. Identifikovat případy, kdy jsou vhodné vazby 1:1, 1:many, many:1, many to many 

3. Definovat a použít „measures“, „custom columns“ a vytvářet sloupce s hierarchií

4. Identifikovat a použít správně „CROSSFILTER“ nebo „bi-directional“ filtering

5. Identifikovat a použít základní DAX výrazy, Power Query nebo M

6. Pracovat s „Power Query“ editorem a „Advanced editorem“

7. Pracovat s aktivními vazbami a modelem typu „hvězda“

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… pokud to jde, vždy pracujte s hvězdou ;) Bohužel, občas to opravdu nejde, ale stačí 

si uvědomit co to v našem modelu udělá napřáklad s filtrováním. 

https://docs.microsoft.com/en-us/power-bi/guidance/star-schema
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6 / ANALYTICKÉ FUNKCE
60

• Analytics pane https://docs.microsoft.com/en-us/power-bi/transform-

model/desktop-analytics-pane

• Python scripts in PBI https://docs.microsoft.com/en-us/power-bi/connect-

data/desktop-python-scripts

• Cohort analysis https://finance-bi.com/blog/power-bi-cohort-analysis/

• Run R scripts in PBI https://docs.microsoft.com/en-us/power-bi/connect-

data/desktop-r-scripts

• Azure Cognitive services https://azure.microsoft.com/services/cognitive-

services/
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1. Pracovat s analytickým panelem a „reference lines“

2. Inentifikovat vizualizace napsané v R nebo Pythonu a používat „forecasts“

3. Sestavit „Top N“ žebříčky 

4. Identifikovat „outliners“ ve vzorci dat, skupiny nebo trendy

5. Aplikovat AI Insights, použít „Smart Narrative“ vizuál, připravit data pro Q&A a použít Q&A

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… více podrobností je na následujícím snímku

https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-analytics-pane
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Reference lines

• Minimum

• Maximum

• Average

• Median

• Percentile

• Anomaly detection

Nova je Anomaly detection, ktera funguje v pripade, ze pouzijete alespon jedno pole 

typu datum a cas
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1. Pracovat s analytickým panelem a „reference lines“

2. Inentifikovat vizualizace napsané v R nebo Pythonu a používat „forecasts“

3. Sestavit „Top N“ žebříčky 

4. Identifikovat „outliners“ ve vzorci dat, skupiny nebo trendy

5. Aplikovat AI Insights, použít „Smart Narrative“ vizuál, připravit data pro Q&A a použít Q&A

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… více podrobností je na následujícím snímku

https://docs.microsoft.com/en-us/power-bi/create-reports/desktop-r-visuals

https://docs.microsoft.com/en-us/power-bi/connect-data/desktop-python-visuals
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R & Python visuals

Scatter chart Python visual R script visual

Integrace Pythonu s Power BI umoznuje zpracovavat data z datasetu v pokrocilych

vizualizacich za psani Python kodu do okna prikazu primo pod vizualizaci. I kdyz uz je 

dneska jeho integrace o dost jednodussi, protoze novy Power BI desktop v podstate

pocita s tim, ze R & Python budete pouzivat a vizualizace obsahuje v zakladu hned po 

instalaci, nejakemu stahovani modulu ktere potrebujete (a jen tech, ktere opravdu

potrebujete) a drobnemu nastavovani se nevyhnete, tak mate ode me mate navod v 

poznamkach k snimku s vice podrobnostmi. To same plati i o R, coz je programovací

jazyk pouzivany pro statistické výpočtya analalýzu. V Power BI můžeme R použít pro 

vizualizaci nad nejakym obecnym datovym zdrojem nebo ho muzeme pouzit primo 

jako kontektor. 

https://www.sqlshack.com/power-bi-desktop-and-python-like-peanut-butter-and-

chocolate/

https://www.red-gate.com/simple-talk/databases/sql-server/bi-sql-server/power-bi-

introduction-working-with-r-scripts-in-power-bi-desktop-part-3/

https://pandas.pydata.org/pandas-

docs/version/0.23/generated/pandas.DataFrame.plot.html

https://cran.r-project.org/bin/windows/base/

https://dataveld.com/2018/11/10/5-performance-tips-for-r-and-python-scripts-in-

power-bi/
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1. Pracovat s analytickým panelem a „reference lines“

2. Inentifikovat vizualizace napsané v R nebo Pythonu a používat „forecasts“

3. Sestavit „Top N“ žebříčky 

4. Identifikovat „outliners“ ve vzorci dat, skupiny nebo trendy

5. Aplikovat AI Insights, použít „Smart Narrative“ vizuál, připravit data pro Q&A a použít Q&A

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://www.sqlbi.com/articles/filtering-the-top-3-products-for-each-category-in-

power-bi/
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1. Pracovat s analytickým panelem a „reference lines“

2. Inentifikovat vizualizace napsané v R nebo Pythonu a používat „forecasts“

3. Sestavit „Top N“ žebříčky 

4. Identifikovat „outliners“ ve vzorci dat, skupiny nebo trendy

5. Aplikovat AI Insights, použít „Smart Narrative“ vizuál, připravit data pro Q&A a použít Q&A

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

https://datacornering.com/how-to-identify-outliers-in-microsoft-power-bi/

https://blog.pragmaticworks.com/power-bi-custom-visuals-play-axis

https://docs.microsoft.com/en-us/learn/modules/perform-analytics-power-bi/2-

statistical-summary?ns-enrollment-type=LearningPath&ns-enrollment-id=learn-

bizapps.data-analysis-power-bi
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1. Pracovat s analytickým panelem a „reference lines“

2. Inentifikovat vizualizace napsané v R nebo Pythonu a používat „forecasts“

3. Sestavit „Top N“ žebříčky 

4. Identifikovat „outliners“ ve vzorci dat, skupiny nebo trendy

5. Aplikovat AI Insights, použít „Smart Narrative“ vizuál, připravit data pro Q&A a použít Q&A

Co se předpokládá, že umíte

3 Options

A wonderful serenity

A wonderful serenity

… více podrobností je na následujícím snímku

https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-ai-insights

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-smart-

narrative
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AI Insights

• Reference line  (Analytics pane for some visuals)

• Smart narrative  (Insert > AI visuals)

• Key influencers  (Insert > AI visuals)

• Decomposition tree  (Insert > AI visuals)

• Q&A (Insert > AI visuals)

• Insights  (PBI cloud > report > … > Insights)

• Text analytics  (Query Editor > Home > AI Insights)  PRO

• Vision  (Query Editor > Home > AI Insights)  PRO

• Azure Machine Learning (Query Editor > Home > AI Insights)  PRO

https://docs.microsoft.com/en-us/power-bi/transform-model/dataflows/dataflows-introduction-self-service

https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-ai-insights

Text > language detection, key phrase extraction

Vision > image tagging

Machine learning > dynamic power query functions or M functions
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• Klikejte, zkoušejte a testujte

• Podívejte se na vzorové otázky

• Projděte si obsah Microsoft Learn portálu

• Založte si O365 tenant na zkoušku s PBI PRO trial

3 Options

A wonderful serenity

A wonderful serenity

Rady na závěr
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Děkuji za pozornost
Držím palce u zkoušky!
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